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IgG Purity and Heterogeneity Assay Kit

The SCIEX IgG Purity and Heterogeneity Assay Kit includes the following:
 • reagents and supplies for sample preparation

 • methods for a PA 800 Plus Pharmaceutical Analysis System that resolve both reduced and non-reduced 
immunoglobulins by size, and to quantify heterogeneity and the impurities that might exist in an IgG 
preparation

This document provides instructions for sample preparation using the IgG Purity and Heterogeneity Assay Kit. 
It also provides instructions for data acquisition and data analysis using the PA 800 Plus Software and Waters 
Empower 3 Software (FR4).

Safety

Refer to the Safety Data Sheets (SDS), available at sciex.com/tech-regulatory, for information about the proper 
handling of materials and reagents. Always follow standard laboratory safety guidelines. Refer to Hazardous 
Substance Information for hazardous substances information.

Intended Use

The IgG Purity and Heterogeneity Assay Kit is for laboratory use only.

Note: Refer to the System Overview Guide for instructions for safe use of the system.

Note: For accurate results, we strongly recommend using IgG analysis with a PA 800 Plus System that has 
been qualified with an Operational Qualification.
Application Guide IgG Purity and Heterogeneity Assay Kit For the PA 800
Plus Pharmaceutical Analysis System
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IgG Purity and Heterogeneity Assay Kit
Introduction

The methodology involves heat denaturing of a specified concentration of protein in the presence of SDS. 
After being denatured, the sample components are separated by size in a capillary containing a replaceable 
SDS polymer matrix. The matrix provides the sieving selectivity for the separation.

Two types of analysis methods have been optimized:

 • The high-resolution methods use the capillary cartridge in the left to right configuration, with a sample 
introduction inlet to detection window distance of 20.0 cm.

 • The high-speed methods use the capillary cartridge in the right to left configuration, with an inlet to 
detection window distance of 10 cm.

High-resolution (HR) methods provide high resolution for protein separation (in about 30 minutes). The 
procedure that follows uses the high-resolution methods.

Internal Standard

A 10 kDa protein Internal Standard is used as a mobility marker. The mobility of all protein samples are 
calculated relative to this mobility marker allowing for more accurate size estimation and analyte 
identification.

IgG Control Standard

The IgG Control Standard is an IgG standard that can be used as an experimental control when using the
SDS-MW Gel Buffer to determine the purity and heterogeneity of reduced and non-reduced antibody samples.

Sample Buffers

 • SDS-MW Sample Buffer: The SDS-MW Sample Buffer is provided as part of the IgG Purity and 
Heterogeneity Assay Kit. This buffer consists of 100 mM Tris-HCl at pH 9.0 with 1% SDS.

 • Low pH SDS sample buffers: In some cases, a sample buffer with a lower pH (than that of the SDS-MW 
Sample Buffer) might improve sample stability by minimizing protein degradation. For these samples, the 
SCIEX low pH SDS sample buffers are available separately:

— Low pH SDS Sample Buffer: This buffer consists of 100 mM Tris-HCl at pH 6.8 with 1% SDS.

— Low pH Phosphate SDS Sample Buffer: This buffer consists of 40 mM Phosphate at pH 6.5 with 1% SDS. 
This buffer meets the Chinese Pharmacopeia specification.

Note: This application guide has been validated with the PA 800 Plus Pharmaceutical Analysis System.
IgG Purity and Heterogeneity Assay Kit For the PA 800 
Plus Pharmaceutical Analysis System

Application Guide
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IgG Purity and Heterogeneity Assay Kit
Equipment and Materials Required

Note: For items with a reorder part number, sometimes the reorder quantity is different than the quantity in 
the kit.

Table 1  Kit Contents (PN A10663)

Component Quantity Reorder Part 
Number

Capillary, 50 μm i.d. bare-fused silica 2 338451

SDS-MW Gel Buffer, proprietary formulation, pH 8.0, 0.2% SDS 140 mL, 4-pack A30341

SDS-MW Sample Buffer, 100 mM Tris-HCl, pH 9.0, 1% SDS 50 mL N/A

IgG Control Standard, 1 mg/mL 1 mL, 3-pack 391734

Internal Standard, 10 kDa protein, 5 mg/mL 0.4 mL A26487

Acid Wash/Regenerating Solution, 0.1 M HCl 100 mL N/A

Basic Wash Solution, 0.1 M NaOH 100 mL 338424

Table 2  Additional Supplies from SCIEX

Component Quantity Part Number

(Optional) Low pH SDS Sample Buffer, 100 mM Tris-HCl, pH 6.8, 1% SDS 140 mL C44807

(Optional) Low pH Phosphate SDS Sample Buffer, 40 mM Phosphate, pH 6.5, 1% SDS 140 mL C57805

Micro Vials, 200 μL 100 144709

Universal Vial Caps, blue 100 A62250

Universal Vials 100 A62251

Table 3  Additional Required Reagents or Supplies

Description Vendor Part Number

2-mercaptoethanol Sigma-Aldrich M7154

Iodoacetamide Sigma-Aldrich I-1149

(Optional) Amicon Ultra-4 Centrifugal Filter Unit with Ultracel-30 membrane Millipore UFC803096
Application Guide IgG Purity and Heterogeneity Assay Kit For the PA 800
Plus Pharmaceutical Analysis System
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IgG Purity and Heterogeneity Assay Kit
Storage Conditions

 • Upon receipt, store the 10 kDa Internal Standard at 2 °C to 8 °C.

 • Upon receipt, prepare 95 μL aliquots of the IgG Control Standard and store them promptly at –20 °C.

 • Store the capillary, SDS-MW Sample Buffer, SDS-MW Gel Buffer, Acid Wash/Regenerating Solution, and 
Basic Wash Solution at room temperature.

 • Store the Low pH SDS Sample Buffer and Low pH Phosphate SDS Sample Buffer at room temperature.

Customer-Supplied Equipment and Supplies

 • Powder-free gloves, neoprene or nitrile recommended

 • Safety glasses

 • Laboratory coat

 • Table-top mini centrifuge

 • Microcentrifuge, or equivalent, and microcentrifuge tubes

 • Water bath or heat block, 37 °C to 100 °C

 • Vortex mixer

 • Centrifugal vacuum evaporator

 • Analytical balance

 • Pipettes and appropriate tips

 • Parafilm

 • Spatula

 • Double-deionized (DDI) water (MS-grade water filtered through a 0.2 μm filter and with resistance 
greater than 18 MΩ)

Required Detector

A photodiode array (PDA) detector is required.

Required Cartridge or Capillary

One of the following:

 • Pre-assembled cartridge (PN A55625)

 • Capillary cartridge (PN 144738) and capillaries, bare-fused silica, 50 μm i.d. (PN 338451)

Note: If the gel buffer or sample buffers are refrigerated, then precipitates might form. If precipitates are 
present, stir the buffer until the precipitate is fully dissolved before using.
IgG Purity and Heterogeneity Assay Kit For the PA 800 
Plus Pharmaceutical Analysis System

Application Guide
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IgG Purity and Heterogeneity Assay Kit
Methods and Sequences

The methods and sequences files are installed on the PA 800 Plus controller. They are not available for 
download. The methods and sequences can also be created manually. Refer to Methods.

The following methods are in the PA 800 Plus controller at C:\32Karat\projects\IgG Purity\Method.

 • IgG HR Conditioning - PA 800 plus.met: Conditions the capillary at the start of each day. In the method 
names, HR indicates high resolution and HS indicates high speed.

 • IgG HR Separation - PA 800 plus.met: Performs an IgG separation.

 • IgG HR Shutdown - PA 800 plus.met: Shuts down and cleans the capillary at the end of a sequence, rinses 
the capillary for storage, and then turns off the UV lamp or, in the PDA detector, turns off the laser.

 • IgG HS Conditioning - PA 800 plus.met: Conditions the capillary at the start of each day.

 • IgG HS Separation - PA 800 plus.met: Performs an IgG separation.

 • IgG HS Shutdown - PA 800 plus.met: Shuts down and cleans the capillary at the end of a sequence, rinses 
the capillary for storage, and then turns off the UV lamp or, in the PDA detector, turns off the laser.

The following sequences are in the PA 800 Plus controller at C:\32Karat\projects\IgG Purity\Sequence.

 • IgG HR - 24 samples - PA 800 plus.seq: Contains the sequence table with high-resolution (HR) methods and 
can run up to 24 samples where sample number 1 is (always) the IgG Control Standard.

 • IgG HR - PA 800 plus.seq: Contains the sequence table with high-resolution (HR) methods and can run up 
to 8 samples of the IgG Control Standard for troubleshooting purposes or can be changed to your desired 
number of samples with proper sample ID and used where sample number 1 is (always) the IgG Control 
Standard.

 • IgG HS - PA 800 plus.seq: Contains the sequence table with high-speed (HS) methods, and can run up to 
8 samples of the IgG Control Standard or can be modified to include customer samples.

Prepare the Samples

Prepare the IgG Control Standard (Reduced)

1 Thaw one of the 95 μL aliquots of the IgG Control Standard at room temperature.

2 Add 2 μL of the 10 kDa Internal Standard to the IgG tube.

3 Inside a fume hood, add 5 μL of 2-mercaptoethanol to the IgG tube.

Note: The following information applies to users using the PA 800 Plus System with the PA 800 Plus and 
32 Karat™ Software. If the system will be used with the Empower™ Software, then the methods are different. 
Refer to Run the Samples with the Waters Empower™ Software.
Application Guide IgG Purity and Heterogeneity Assay Kit For the PA 800
Plus Pharmaceutical Analysis System
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IgG Purity and Heterogeneity Assay Kit
4 Cap the tube and then mix thoroughly.

5 Using a centrifuge, spin the tube for 1 minute at 300 g.

6 Seal the vial cap with Parafilm and then heat the vial at 70 °C for 10 minutes.

7 Allow the tube to cool down to room temperature for at least 3 minutes.

8 Using a centrifuge, spin the tube for 1 minute at 300 g to collect all liquid to the bottom of the tube.

9 Transfer 70 μL to 90 μL of the prepared sample to a micro vial, put the micro vial inside a universal vial, 

then cap the universal vial.

Prepare the IgG Control Standard (Non-reduced)

Before preparing the IgG non-reduced control standard, prepare a 250 mM iodoacetamide (IAM) solution. The 
IAM solution acts as the alkylation reagent during preparation of the IgG non-reduced control standard. The 
IAM solution is stable for approximately 24 hours at room temperature.

Prepare the Alkylation Reagent (250 mM IAM Solution)

1 Weigh 46 mg of iodoacetamide (IAM).

2 Transfer the IAM to a 1.5 mL centrifuge tube.

3 Add 1 mL of DDI water to the 1.5 mL centrifuge tube.

4 Cap the vial tightly, mix until dissolved, and then store the vial in the dark at room temperature. The 

solution is stable for approximately 24 hours at room temperature.

Prepare the Non-reduced IgG Control Standard

1 Thaw one of the 95 μL aliquots of the IgG Control Standard at room temperature.
IgG Purity and Heterogeneity Assay Kit For the PA 800 
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2 Add 2 μL of the 10 kDa Internal Standard to the IgG Control Standard tube.

3 Add 5 μL of a 250 mM IAM solution.

4 Cap the tube and then mix throughly.

5 Using a centrifuge, spin the tube for 1 minute at 300 g.

6 Seal the tube with Parafilm and then heat the tube at 70 °C for 10 minutes.

7 Allow the tube to cool down to room temperature for at least 3 minutes.

8 Using a centrifuge, spin the tube for 1 minute at 300 g to collect all liquid to the bottom of the tube.

9 Transfer 70 μL to 90 μL of the prepared sample to a micro vial. Put the micro vial inside a universal vial, 

then cap the universal vial.

Prepare the IgG Sample

Prepare the Reduced IgG Sample

1 Pipette 100 μg of IgG sample in a volume less than 45 μL to a 0.5 mL microcentrifuge tube.

2 Add 50 μL to 95 μL of SDS-MW Sample Buffer to give a final volume of 95 μL.

3 Add 2 μL of the 10 kDa Internal Standard to the IgG sample tube.

4 Inside a fume hood, add 5 μL of 2-mercaptoethanol to the IgG sample tube.

5 Cap the tube tightly and mix thoroughly.

Note: If the sample concentration is less than 10 mg/mL and the buffer concentration is more than 50 mM, 
then use the Amicon Ultra-4 centrifugal filter unit to exchange the buffer with the SDS-MW Sample Buffer. 
Refer to Perform a Buffer Exchange for the IgG Sample.
Application Guide IgG Purity and Heterogeneity Assay Kit For the PA 800
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6 Using a centrifuge, spin the tube for 1 minute at 300 g.

7 Seal the tube with Parafilm and then heat the tube in a water bath at 70 °C for 10 minutes.

8 Allow the tube to cool down to room temperature for at least 3 minutes.

9 Using a centrifuge, spin the tube for 1 minute at 300 g to collect all liquid to the bottom of the tube.

10 Transfer 70 μL to 90 μL of the prepared sample to a micro vial. Put the micro vial inside a universal vial, 

then cap the universal vial. Make sure there are no bubbles in the micro vial.

Prepare the Non-reduced IgG Sample

Under non-reduced conditions, heating the sample solution at high temperature is required to accelerate SDS 
binding. However, heating an IgG sample at high temperature might introduce fragmentation and 
aggregation, and introduce artifacts to the sample analysis.

To alleviate these temperature-induced artifacts, first alkylate the IgG sample using the following procedure.

1 Pipette 100 μg of IgG sample to a 0.5 mL microcentrifuge tube.

2 Add 50 μL to 95 μL of SDS-MW Sample Buffer to give a final volume of 95 μL.

3 Add 2 μL of the 10 kDa Internal Standard to the IgG sample tube.

4 Inside a fume hood, add 5 μL of the 250 mM IAM solution to the IgG sample tube. Refer to Prepare the 

Alkylation Reagent (250 mM IAM Solution).

5 Cap the tube tightly and mix thoroughly.

6 Using a centrifuge, spin the tube for 1 minute at 300 g.

Tip! To remove bubbles from the micro vial, use a pipette to gently aspirate any bubbles.
IgG Purity and Heterogeneity Assay Kit For the PA 800 
Plus Pharmaceutical Analysis System

Application Guide

12 / 66 RUO-IDV-05-6935-C



IgG Purity and Heterogeneity Assay Kit
7 Seal the tube with Parafilm and then heat the mixture in a water bath at 70 °C for 10 minutes.

8 Allow the tube to cool down to room temperature for at least 3 minutes.

9 Using a centrifuge, spin the tube for 1 minute at 300 g to collect all liquid to the bottom of the tube.

10 Transfer 70 μL to 90 μL of the prepared sample to a micro vial. Put the micro vial inside a universal vial, 

then cap the universal vial. Make sure there are no bubbles in the micro vial.

Perform a Buffer Exchange for the IgG Sample

1 Add 1 mL of IgG sample to filter unit.

2 Using a centrifuge, spin the sample for 15 minutes at 4,000 g. Discard the filtrate. 

3 Add 2 mL of SDS-MW Sample Buffer, then use a centrifuge and spin for 25 minutes at 4,000 g.

4 Put the filter unit inside a new vial in an inverted position and then use a centrifuge to spin the vial for 

3 minutes at 1,000 g. The IgG solution will collect in the vial.

5 Transfer the collected protein to an appropriate sterile tube. Add SDS-MW Sample Buffer to give a final 

volume of 1 mL.

Tip! To remove bubbles from the micro vial, use a pipette to gently aspirate any bubbles.

Note: The signal intensity and resolution of this assay is sensitive to the salt concentration in the IgG sample. 
If the salt concentration is too high, then low signal and peak tailing is likely to occur. Exchange the SDS-MW 
Sample Buffer with an Amicon Ultra-4 centrifugal filter unit using the following procedure.

Note: For desalting/buffer exchange procedures using a device from another vendor, read the user guide 
from the vendor before use.
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Prepare the PA 800 Plus System

This section describes the steps to prepare the PA 800 Plus System to acquire data.

The procedures described in this section assume the system has already been properly installed and 
initialized.

Install the PDA Detector

1 Turn off the PA 800 Plus System and then install the PDA detector. Refer to the System Maintenance Guide.

2 Turn on the system and permit the UV lamp to warm up for at least 30 minutes.

Clean the Interface Block

Clean the electrodes, opening levers, capillary tips, and interface block weekly or when changing chemistries. 
Refer to the System Maintenance Guide for detailed instructions.

The SDS-MW Gel Buffer is very viscous and will accumulate on the capillary ends, electrodes, interface block, 
and opening levers unless regular and thorough cleaning is performed.

Install the Cartridge and Calibrate the Detector

1 Remove the cartridge from the box and, if necessary, install the capillary.

2 Install the cartridge in the PA 800 Plus System. Refer to the System Maintenance Guide.

3 Close the front panel.

CAUTION: Potential System Damage. Do not allow the gel to accumulate on the electrodes, opening 
levers, capillary ends, and interface block. Gel accumulation might cause broken capillaries, bent 
electrodes, jammed vials, or missed injections.

Note: To make sure that the analysis results are consistent over time, we strongly recommend calibrating 
the detector each time it is installed in the PA 800 Plus System. Also calibrate the detector after replacing 
the capillary in the cartridge or installing a different cartridge.

Note: For Empower™ Software users, calibration instructions are located in the PA 800 Plus Empower™ 
Driver User Guide.
IgG Purity and Heterogeneity Assay Kit For the PA 800 
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4 Calibrate the detector.

Click the rainbow above the lamp in the Direct Control window to open the PDA Detector Parameters 
dialog and then click Calibrate. Refer to the System Maintenance Guide.

Load the Buffer Trays

Refer to Hazardous Substance Information for additional information.

1 Depending on the number of samples to be run, fill the appropriate number of vials and then cap them 

with the blue caps. For each set of eight samples, prepare the following:

 • 3 universal vials, containing 1.2 mL of SDS-MW Gel Buffer, for the Gel-R positions

 • 3 universal vials, containing 1.1 mL of SDS-MW Gel Buffer, for the Gel-S positions

 • 12 universal vials, containing 1.5 mL of DDI water, for the H2O positions

 • 3 universal vials, containing 1.5 mL of Acid Wash/Regenerating Solution, for the HCl positions

 • 3 universal vials, containing 1.5 mL of Basic Wash Solution, for the NaOH positions

 • 9 universal vials, containing 1.0 mL of DDI water, for the Waste positions in the outlet buffer tray

DANGER! Toxic Chemical Hazard. Read the Safety Data Sheets for Acid Wash/Regenerating 
Solution (0.1 M HCl), Basic Wash Solution (0.1 M NaOH), and SDS-MW Gel Buffer before use.

Note: Before starting the separation, bring the SDS-MW Gel Buffer and the SDS-MW Sample Buffer to room 
temperature.

Note: Make sure to fill the buffer vials with SDS-MW Gel Buffer without producing bubbles and use the 
recommended volume. If the volume is too low (less than half of the vial volume), then the capillary and 
electrode might not be able to dip in the SDS-MW Gel Buffer during the separation. If the volume is too high, 
then the SDS-MW Gel Buffer might accumulate on the capillary ends and electrodes, resulting in system 
failure.

CAUTION: Potential System Damage. Do not fill the waste vial with more than 1.8 mL. If the vial 
has more than 1.8 mL, the pressure system might be damaged.
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Figure 1  Universal Vial and Cap Setup

2 Put the vials in the buffer trays. Refer to Figure 2 and Figure 3.

1. Universal vial cap
2. Maximum fill line
3. Universal vial

Note: The vial positions in the following figures are for the high-resolution sequence. If the high-speed 
sequence is being used, then reverse the positions of the vials. Refer to Figure 4.

IMPORTANT For this application, all vials and caps are designed for a maximum of eight runs. Do 
not reuse the caps because they might be contaminated with dried gel and other chemicals.
IgG Purity and Heterogeneity Assay Kit For the PA 800 
Plus Pharmaceutical Analysis System

Application Guide

16 / 66 RUO-IDV-05-6935-C



IgG Purity and Heterogeneity Assay Kit
Figure 2  Inlet Buffer Tray Layout

A1 to A6: 1.5 mL DDI H2O, used in dip step to clean capillary tip

B4 to B6: 1.5 mL DDI H2O, used in dip step to clean capillary tip

B1 to B3: 1.2 mL SDS-MW Gel Buffer, used to rinse/fill capillary prior each cycle (Gel-R)

C1 to C3: 1.1 mL SDS-MW Gel Buffer, used for separation (Gel-S)

D1 to D3: 1.5 mL 0.1 M NaOH solution, used to precondition capillary

E1 to E3: 1.5 mL 0.1 M HCl solution, used to precondition capillary

F1 to F3: 1.5 mL DDI H2O, used to precondition capillary
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Figure 3  Outlet Buffer Tray Layout

A1 to A6: 1.5 mL DDI H2O, used in dip step to clean capillary tip

B4 to B6: 1.5 mL DDI H2O, used in dip step to clean capillary tip

B1 to B3: 1.0 mL DDI H2O, waste for SDS-MW Gel Buffer rinse

C1 to C3: 1.1 mL SDS-MW Gel Buffer, used for separation

D1 to D3: 1.0 mL DDI H2O, waste for 0.1 M NaOH solution rinse

E1 to E3: 1.0 mL DDI H2O, waste for 0.1 M HCl solution rinse

F1 to F3: 1.0 mL DDI H2O, waste for DDI H2O rinse

Note: During electrophoresis the ionic strength of the buffer will change. The separation method is 
programmed to increment the buffer vials after eight runs to avoid ionic depletion.
IgG Purity and Heterogeneity Assay Kit For the PA 800 
Plus Pharmaceutical Analysis System

Application Guide

18 / 66 RUO-IDV-05-6935-C



IgG Purity and Heterogeneity Assay Kit
Buffer Trays for a High-speed Separation

For high-speed separations, put the vials in the inlet and outlet buffer trays as shown in Figure 4.

Figure 4  Buffer Tray Layout for High-speed Separations

Load the Sample Tray

1 Prepare the samples. For each sample:

a. Make sure the prepared samples are at room temperature.

b. Put 70 μL to 90 μL of the sample in a micro vial.

c. Make sure that no bubbles are present at the bottom of the vials. If bubbles are present, then use a 
centrifuge to spin the micro vials for 2 minutes at 1,000 g. Repeat if necessary.
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2 Put the micro vial in a universal vial, and then cap the universal vial.

Figure 5  Sample Vial Setup

3 Put the universal vials in positions A1:C8 in the sample tray. Refer to Figure 6. For fewer than 24 samples, 

start at position A1 and fill all the A wells before filling any other wells.

Figure 6  Sample Tray Layout

1. Universal vial cap
2. Micro vial

3. Universal vial
4. Micro vial inside universal vial
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Run the Samples

Create the Sequence and Start the Run

1 Double-click the PA 800 Plus Software icon on the desktop.

2 In the PA 800 Plus window, click  (Run) in the upper right corner of the window.

3 In the Application list, click IgG Purity. In the Sequence list, click Browse and select IgG HS - PA 800 plus.

If system administration is enabled, type a user name and password when prompted, and then click OK. 
Refer to Figure 7. The default user name is pa800, and the default password is plus.

Figure 7  User Name and Password Entry

The Instrument Status and Direct Control window opens. Refer to Figure 8.

Note: For Empower™ Software users, refer to Run the Samples with the Waters Empower™ Software.
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Figure 8  Instrument Status and Direct Control Window: Idle

4 In the Instrument Status and Direct Control window, click  (Next) in the bottom right corner of the 

window.

The sequence opens.

5 Select IgG HS - PA 800 plus to open the sequence. This sequence will run a maximum of 24 samples where 

sample 1 is (always) the IgG Control Standard.

6 Click  (Describe) in the upper right corner of the window to edit the sequence.

Use the Describe function to customize the sequence table and edit the number of samples that can be run 
in the sequence. The Describe function can also be used to set the row types.

7 In the Application list, click IgG Purity. In the Sequence list, click Browse, and then select IgG HS - PA 800 

plus. If prompted, type a user name and password.

The page updates to show the selected sequence, and all rows in the sequence are designated as samples.

8 (Optional) Edit the Sample ID and the Data File Name as desired.

Editable fields such as Sample ID and Data File Name can be set as Mandatory, Optional, or Fixed.

9 After the sequence is loaded, set rows to Sample, Control, or Always. Click a row to select it and then click 

the button in the Rows area.
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Capillary Conditioning and Shutdown runs are set as Always. Refer to Figure 9. Run #2 is set as Control. 
Sample ID is set as Optional. Reps are set as Required.

Figure 9  Describe sequence rows and columns Window – Conditioning Method Set to “Always”
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10 In the lower right corner of the window, click  (Save) and then click  (Finish). The Run 

Sequence window opens. Refer to Figure 10.

Figure 10  Describe sequence rows and columns Window – Reload Sequence

The number of samples shown for this sequence is 23 instead of 24 because the first run is the control. If 
required, the user can reduce the number the samples to be run in the sequence in the Run Sequence 
window by editing the Number of samples list.

11 Click Load to load the sample and reagent vials as shown in Figure 10 and then close the door.

Note: In the upper left corner next to Run #1 of the table in Figure 10, a blinking red exclamation mark 
indicates that the sequence has changed and that the software expects an action from the user. Move 
the cursor over the exclamation point to view a tooltip with the required action. In this example, the user 

is prompted to click  (Reload sequence) to update the sequence.

A required action is also used if the data file name is a required field, and the data file does not contain 
any information. In this case, the user is required to enter the appropriate data file name.
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12 Click (Next) and then click Yes - run now.

Figure 11  PA 800 Plus System During Data Acquisition

Waste Disposal

Store the Cartridge

Store the Cartridge for Less Than 10 Days

1 Perform a shutdown method to clean the capillary.

The shutdown method fills the capillaries with water.

WARNING! Biohazard or Toxic Chemical Hazard. Follow local directives when disposing 
of chemicals, vials and caps, and the remains of the prepared samples, if applicable. 
They might contain regulated compounds and biohazardous agents.
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2 Store the cartridge for up to 10 days in the system with the capillary ends immersed in vials of DDI water.

Store the Cartridge for More Than 10 Days

1 Perform a shutdown method to clean the capillary.

2 Rinse the capillary with DDI water for 10 minutes at 100 psi.

3 Remove the cartridge from the system.

4 Store the cartridge upright in the cartridge box at room temperature, with the capillary ends immersed 

in vials of DDI water.

Prepare the Cartridge After Storage

 • If the cartridge has not been used for more than a day or it has been stored for an extended time, then 
condition the capillary using the IgG Conditioning method.
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Analyze the Results

Typical Results for the Reduced IgG Control Standard

The IgG Control Standard used with this assay includes a controlled percentage of non-glycosylated heavy 
chain, which provides both a resolution and a quantification benchmark. Figure 12 illustrates a typical 
electropherogram of the reduced IgG control standard for the suitability test.

With this assay, the suitability standard is used to confirm the identification of the known IgG control 
elements of the IgG light chain (LC), the heavy chain (HC), the non-glycosylated heavy chain (NG), and the
10 kDa Internal Standard (10 kD). The glycosylated heavy chain should be baseline resolved from the non-
glycosylated heavy chain (resolution > 1). The quantification benchmark is given as the percentage of the total 
heavy chain present in the IgG control. Refer to the Certificate of Analysis shipped with the Internal Standard 
for the percentage.

Figure 12  Electropherogram of IgG Control Standard Using High-resolution Methods Under Reducing Conditions

 • 10KD: 10 kDA Internal Standard

 • LC: light chain

 • NG: non-glycosylated heavy chain

 • HC: heavy chain
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Typical Results for the Non-reduced IgG Control Standard

Under non-reducing conditions, all of the impurities, such as the light chain (LC), the heavy chain (HC), the 
heavy-heavy chain (HH), and the 2 heavy 1 light chain (2H1L), resolve from the whole antibody.

Figure 13  Electropherogram of IgG Control Standard Using High-resolution Methods Under Non-reducing Conditions

 • 10KD: 10 kDA Internal Standard

 • LC: light chain

 • HC: heavy chain

 • HH: heavy-heavy chain

 • 2H1L: 2 heavy 1 light chain

 • NG: non-glycosylated heavy chain
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Troubleshooting

Table 4  Troubleshooting

Symptom Possible Cause Corrective Action

Failed system suitability test Incorrect capillary length or 
improperly-positioned reagents 
and samples

Inspect the capillary length, buffer tray, and 
sample tray first. Make sure that all the reagents 
and samples are in the right place as described in 
the buffer tray maps. Evaluate the integration and 
peak identification windows. Refer to the other 
symptoms below for additional troubleshooting 
tips.

Shifts in migration with low or 
erratic current

Plugged capillary 1) Rinse the capillary with DDI water at 100 psi for 
10 minutes and then perform the capillary 
conditioning method.

2) If low or unsteady current continues, replace the 
capillary.

Air bubbles in the gel Degas SDS-MW Gel Buffer under 5 Hg to 15 Hg 
vacuum for 5 minutes.

Contaminated electrode Clean electrodes. Refer to the System Maintenance 
Guide for further instructions.

High current Contaminated gel buffer Replace the SDS-MW Gel Buffer as needed.

Contamination of the electrode Clean the electrodes. Refer to the System 
Maintenance Guide.

Spikes in electropherogram Air bubbles in gel buffer Degas SDS-MW Gel Buffer under a 5 Hg to 15 Hg 
vacuum for 5 minutes.

Broad peaks, poor resolution Poor capillary end cut Inspect the capillary end under magnification. If 
the cut is jagged, then cut the end again, or replace 
the capillary.

Improper reduction of sample Reduce the sample using the recommended 
procedure. Use fresh 2-mercaptoethanol for 
sample reduction. Refer to Prepare the Reduced 
IgG Sample.

Deteriorated capillary 1) Rinse the capillary with DDI water for 10 minutes 
at 100 psi and then perform the capillary 
conditioning method.

2) Install a new capillary if the same problem is 
observed.

Dust or gel build up on capillary end Clean the capillary tip using DDI water.
Refer to Clean the Interface Block.
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No peaks or low signal Capillary inlet longer than the inlet 
electrode

Push the capillary up inside the cartridge or cut the 
capillary inlet to make sure that it is the same 
length as the electrode.

Dirty or plugged capillary tip 1) Clean the capillary tip using DDI water. Refer to 
Clean the Interface Block.

2) Replace the capillary if the plug cannot be 
removed by water rinses.

Not enough sample Make sure there is a minimum of 20 μL of sample 
in the sample vial.

Slow sample migration Increase the separation time in the method and 
repeat the analysis.

High salt in IgG sample Perform a buffer exchange to remove salt from the 
sample. Refer to Perform a Buffer Exchange for the 
IgG Sample.

Table 4  Troubleshooting (Continued)

Symptom Possible Cause Corrective Action
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APPENDIX A

Hazardous Substance Information

The following information must be noted and the relevant safety measures taken. Refer to the respective 

safety data sheets for more information. These are available upon request or can be downloaded from our 
website, sciex.com/tech-regulatory.

Hazard classification is according to HCS 2012.

Acid Wash/Regenerating Solution (0.1 M HCl)

Basic Wash Solution (0.1 M NaOH)

Low pH SDS Sample Buffer (100 mM Tris-HCl, pH 6.8, 1% SDS)

DANGER! Causes severe skin burns and eye damage.

DANGER! Causes severe skin burns and eye damage.

WARNING! Causes mild skin irritation.
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Hazardous Substance Information
Low pH Phosphate SDS Sample Buffer (40 mM Phosphate, pH 6.5, 
1% SDS)

IgG Control Standard

SDS-MW Sample Buffer (100 mM Tris-HCl, pH 9.0, 1% SDS)

SDS-MW Gel Buffer, proprietary formulation (pH 8.0, 0.2% SDS)

Other Reagents

These components are not classified as hazardous:

 • Internal Standard, 10 kDa protein, 5 mg/mL

For reagents from other vendors, read the Safety Data Sheet from the vendor before use.

WARNING! Causes mild skin irritation.

WARNING! Causes mild skin irritation.

WARNING! Causes mild skin irritation.

DANGER! Causes mild skin irritation. May damage fertility or the unborn child.
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APPENDIX B

Methods

The IgG analysis requires three methods. Two types of separations are possible: high resolution and high 

speed.

Initial Conditions

Figure B.1  Initial Conditions for All Methods

Note: The following information applies to users using the PA 800 Plus System with the PA 800 Plus and
32 Karat™ Software. If the system will be used with the Empower™ Software, then the methods will be 
different. Refer to Run the Samples with the Waters Empower™ Software.

Note: The values on the Initial Conditions and PDA Detector Initial Conditions tabs are the same for all of the 
methods.
Application Guide IgG Purity and Heterogeneity Assay Kit For the PA 800
Plus Pharmaceutical Analysis System

RUO-IDV-05-6935-C  33 / 66



Methods
Detector Initial Conditions

Figure B.2  PDA Detector Initial Conditions for All Methods

Time Programs

The time programs are different for each method.

High-speed Method Time Programs

Figure B.3  Time Program for the IgG HS Conditioning - PA 800 plus Method
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Figure B.4  Time Program for the IgG HS Separation - PA 800 plus Method

Figure B.5  Time Program for the IgG HS Shutdown - PA 800 plus Method

High-resolution Method Time Programs

Figure B.6  Time Program for the IgG HR Conditioning - PA 800 plus Method

Figure B.7  Time Program for the IgG HR Separation - PA 800 plus Method
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Figure B.8  Time Program for the IgG HR Shutdown - PA 800 plus Method
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APPENDIX C

Using the Low pH SDS Sample Buffer
Some samples may be more stable in a sample buffer with a lower pH. To use the Low pH SDS Sample Buffer 
(pH 6.8), prepare the samples as described previously, but replace the SDS-MW Sample Buffer with the Low pH 
SDS Sample Buffer (pH 6.8).

Due to the increased ionic strength of low pH sample buffers, we recommend modifying the SDS-MW 
separation method by increasing the injection voltage or duration to avoid any signal loss. Adjust the 
separation time based on the samples to be analyzed. For example, for analysis of a Rituxan (rituximab) 
sample, change the separation time to 35 minutes.

Alternatively, use a pressure injection in the separation method. Start with the same SDS-MW separation 
method as for samples prepared with the SDS-MW Sample Buffer and edit the method as described in the 
following section.

Add a Pressure Injection to the SDS MW Separation Method

Use the following instructions to add a pressure injection and make other necessary changes to the separation 
method.

1 Open the SDS MW separation method in the 32 Karat™ Software.

No changes to the Initial Conditions or the PDA Detector Initial Conditions are required.

2 Click the Time Program tab.

3 Add a Rinse event after row 5. Set the parameters as shown.

Note: SCIEX carries two different low pH sample buffers, the Low pH SDS Sample Buffer (Tris; pH 6.8) and 
the Low pH Phosphate SDS Sample Buffer (pH 6.5).
Application Guide IgG Purity and Heterogeneity Assay Kit For the PA 800
Plus Pharmaceutical Analysis System

RUO-IDV-05-6935-C  37 / 66



Using the Low pH SDS Sample Buffer
Figure C.1  Rinse Dialog

4 Edit the Inject-Voltage event to match the following figure.

Figure C.2  Inject Dialog

5 Adjust the duration of the Separation-Voltage event based on samples to be analyzed.

The time program should match the following figure.
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Using the Low pH SDS Sample Buffer
Figure C.3  Separation Method Time Program after Editing (showing Rinse and Injection Pressure Events)

6 Save the method. If the method name is not changed, then no changes to the sequence are required.

Results Obtained Using the Low pH SDS Sample Buffer

The following figure shows the results obtained with Rituxan (rituximab) and the Low pH SDS Sample Buffer. 
Refer to Figure C.4. Sample impurity was 1.35%.

Figure C.4  Rituxan (rituximab) Electropherogram Using the Low pH SDS Sample Buffer (Tris)
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Using the Low pH SDS Sample Buffer
A comparison of results obtained with the SDS-MW Sample Buffer (red trace) and the Low pH SDS Sample 
Buffer (blue trace) with the Rituxan (rituximab) is shown in the following figure.

Figure C.5  Comparison of SDS-MW Sample Buffer and Low pH SDS Sample Buffer (Tris) for Rituxan (rituximab)
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APPENDIX D

Using the Low pH Phosphate SDS Sample Buffer
About the Low pH Phosphate SDS Sample Buffer

The Low pH Phosphate SDS Sample Buffer is designed to meet specifications provided in the Chinese 
Pharmacopeia set forth by the Pharmacopoeia Commission of the Ministry of Health of the People’s Republic 
of China for capillary electrophoresis SDS separations.

In addition to specifying the buffer, the Chinese Pharmacopeia (2019-06-27) has recommendations for the 

separation method. Refer to Chinese Pharmacopeia 2020 Edition, Chapter 3127, 3127  单抗分子大小变 异体
测定法 (CE-SDS法) or https://www.chp.org.cn/gjydw/swzp/5032.jhtml. The link was current at the time of 
publication.

Note: SCIEX carries two different low pH sample buffers, the Low pH SDS Sample Buffer (Tris; pH 6.8) and 
the Low pH Phosphate SDS Sample Buffer (pH 6.5).

Note: The Chinese Pharmacopeia specifies a range for some assay parameters instead of a single value. For 
the results in the following figures, the median was used. Specifically, the sample incubation temperature 
was 70 °C and the sample storage and capillary temperatures were 20 °C.
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Using the Low pH Phosphate SDS Sample Buffer
Results Obtained Using the Low pH Phosphate SDS Sample Buffer

Typical Results Using Non-reducing Conditions

The following figure shows the results obtained with NIST mAb and the Low pH Phosphate SDS Sample Buffer 
following the Chinese Pharmacopeia method under non-reducing conditions.

Figure D.1  Electropherogram of Non-reduced NIST mAb Using the Low pH Phosphate SDS Sample Buffer with the 
Chinese Pharmacopeia Method
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Using the Low pH Phosphate SDS Sample Buffer
Typical Results Using Reducing Conditions

The following figure shows the results obtained with NIST mAb and the Low pH Phosphate SDS Sample Buffer 
following the Chinese Pharmacopeia method under reducing conditions.

Figure D.2  Electropherogram of Reduced NIST mAb Using the Low pH Phosphate SDS Sample Buffer with the Chinese 
Pharmacopeia Method

 • LC: light chain

 • NGHC: non-glycosylated heavy chain

 • HC: heavy chain
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Using the Low pH Phosphate SDS Sample Buffer
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APPENDIX E

Run the Samples with the Waters Empower™
Software

This section gives instructions on data acquisition using the Empower™ Software. Refer to the Empower™ 

Software guides and help file for data analysis instructions.

Create the Instrument Methods

Three instrument methods are required:

 • IgG_CONDITIONING

 • IgG_SEPARATION

 • IgG_SHUTDOWN

Note: Calibrate the PDA detector before acquiring data. Refer to the PA 800 Plus Empower™ Driver User 
Guide for instructions.

Note: If a low pH SDS sample buffer is used, the instrument methods might need adjustments to 
accommodate the increased ionic strength of the buffer. Refer to Using the Low pH SDS Sample Buffer.

Note: The validated instrument methods are included on the PA 800 Plus Empower™ Driver DVD. The 
methods can be imported instead of being creating manually. Refer to Import the Instrument Methods. If the 
methods are missing, then use the following instructions to create them.

Note: The following instrument methods are for the high-resolution separation. To perform a high-speed 
separation, refer to the instrument methods described in High-speed Instrument Methods.

Note: The values in the General and Detector tabs are the same for all of the methods.

Note: Pressure values can be shown in millibar (mbar) or pounds per square inch (psi), depending on a 
registry setting for the Empower™ Software. The default unit is millibar. To change the units, refer to the
PA 800 Plus Empower™ Driver Release Notes.

Note: The instrument methods that follow were validated using the SDS-MW Sample Buffer.
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Run the Samples with the Waters Empower™ Software
1 In the Empower™ Software Project window, click File > New Method > Instrument Method.

The Select Desired Chromatography System dialog opens.

Figure E.1  Select Desired Chromatography System Dialog

2 Click the system to be used and then click OK. Make sure that the instrument is configured with a 

PDA detector. 

The Instrument Method Editor opens.
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Run the Samples with the Waters Empower™ Software
3 Set the parameters in the General tab.

Figure E.2  General Parameters for the IgG_HR_CONDITIONING Instrument Method
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Run the Samples with the Waters Empower™ Software
4 Click the Detector tab, select PDA in the Detector Type list, and then set the parameters.

Figure E.3  Detector Parameters for the IgG_HR_CONDITIONING Instrument Method

5 Add the events in the following figure to the time program.

Figure E.4  Time Program for the IgG_HR_CONDITIONING Instrument Method

Note: For 3D data, in Electropherogram Scan Data, select On for Data Rate.

Note: For the pressure in the Separate Voltage Pressure event (step 5), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1, 2, and 3), type 1379.0.

 • For the pressure in the Rinse Pressure event (step 4), type 4826.3.

 • For the pressure in the Separate Voltage Pressure event (step 5), type 1379.0.
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Run the Samples with the Waters Empower™ Software
6 Save the instrument method.

a. Click File > Save. The Save current Instrument Method dialog opens.

b. Type IgG_HR_CONDITIONING in the Name field.

c. (Optional) Type information in the Method Comments field.

d. If prompted, type the Empower™ Software password for the current user in the Password field and 
then click Save.

The instrument method is saved to the current project.

7 Create the separation instrument method.

a. Set the parameters on the General tab. Refer to Figure E.2.

b. Set the parameters on the Detector tab. Refer to Figure E.3.

c. Add the events in the following figure to the time program.

Figure E.5  Time Program for the IgG_HR_SEPARATION Instrument Method

d. Save the method as “IgG_HR_SEPARATION”.

Note: For the pressure in the Separate Voltage Pressure event (step 9), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1 through 4), type 4826.3.

 • For the pressure in the Separate Voltage Pressure event (step 9), type 1379.0.
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Run the Samples with the Waters Empower™ Software
8 Create the shutdown instrument method.

a. Set the parameters on the General tab. Refer to Figure E.2.

b. Set the parameters on the Detector tab. Refer to Figure E.3.

c. Add the events in the following figure to the time program.

Figure E.6  Time Program for the IgG_HR_SHUTDOWN Instrument Method

d. Save the method as “IgG_HR_SHUTDOWN”.

High-speed Instrument Methods

The General and Detector parameters for the high-speed methods are the same as for the high-resolution 
methods. However, the time programs are different.

Figure E.7  Time Program for the IgG_HS_CONDITIONING Instrument Method

Note: For the pressure in the Separate Voltage Pressure event (step 5), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1 and 4), type 4826.3.

 • For the pressure in the Rinse Pressure events (steps 2 and 3), type 3447.4.

 • For the pressure in the Separate Voltage Pressure event (step 5), type 1379.0.

Note: For the pressure in the Separate Voltage Pressure event (step 5), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1, 2, and 3), type 1379.0.

 • For the pressure in the Rinse Pressure event (step 4), type 4826.3.

 • For the pressure in the Separate Voltage Pressure event (step 5), type 1379.0.
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Run the Samples with the Waters Empower™ Software
Figure E.8  Time Program for the High-speed IgG_HS_SEPARATION Instrument Method

Figure E.9  Time Program for the High-speed IgG_HS_SHUTDOWN Instrument Method

Create the Method Sets

Three method sets are required:

 • IgG Conditioning Method Set

 • IgG Separation Method Set

 • IgG Shutdown Method Set

Note: For the pressure in the Separate Voltage Pressure event (step 9), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1 through 4), type 4826.3.

 • For the pressure in the Separate Voltage Pressure event (step 9), type 1379.0.

Note: For the pressure in the Separate Voltage Pressure event (step 9), type 20.

Note: If the system is using mbar as the units for pressure, then type the following:

 • For the pressure in the Rinse Pressure events (steps 1 and 4), type 4826.3.

 • For the pressure in the Rinse Pressure events (steps 2 and 3), type 3447.4.

 • For the pressure in the Separate Voltage Pressure event (step 5), type 1379.0.
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Run the Samples with the Waters Empower™ Software
1 In the Empower™ Software Project window, click File > New Method > Method Set.

2 Click No in the message.

The Method Set Editor window opens.

3 In the Instrument Method list, click IgG_HR_CONDITIONING. Do not make any other changes.

Figure E.10  Method Set Editor Window

4 Save the method set.

a. Click File > Save to open the Save current method set dialog.

b. Type IgG HR Conditioning in the Name field.

c. (Optional) Type information in the Method Comments field.

d. If prompted, type the Empower™ Software password for the current user in the Password field and 
then click Save.

Note: A method set can also include processing and report methods. To create those methods, refer to the 
documentation supplied with the Empower™ Software.
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Run the Samples with the Waters Empower™ Software
Figure E.11  Save current method set Dialog

The method set is saved to the current project.

5 Repeat the previous steps to create two more method sets.

a. Create the separation method set by selecting IgG_HR_SEPARATION in the Instrument Method list.
Save the method set as “IgG Separation”.

b. Create the shutdown method set by selecting IgG_HR_SHUTDOWN in the Instrument Method list.
Save the method set as “IgG Shutdown”.

Configure the Software to Use Multiple Plates

The Empower™ Software is designed for chromatography systems that do not have buffer trays. To use the 
buffer trays, configure the Empower™ Software as follows.
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Run the Samples with the Waters Empower™ Software
1 In the Empower™ Software Run Samples window, click Edit > Plates.

The Define Plates for Sample Set Method dialog opens.

Figure E.12  Define Plates for Sample Set Method Dialog

2 In the first row, set up the buffer inlet tray.

a. Click the Plate Type Name cell and then select PA 800 Plus Buffer Tray.

The dialog updates with an image of the plate and buttons for the plate sequencing mode.

b. Click the Plate Layout Position cell and then type BI.

c. Click  (Vertical Discontinuous Plate Sequencing Mode) to indicate the order in which the vials are 
accessed during the run.

Note: If the dialog does not look like the previous figure, clear the 2790 Layout check box.

Note: If PA 800 Plus Buffer Tray is missing, then the buffer and sample trays might not have been 
defined. Refer to the PA 800 Plus Empower™ Driver User Guide.
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Run the Samples with the Waters Empower™ Software
Figure E.13  After Defining the Buffer Inlet Plate

3 Repeat step 2 to set up the buffer outlet tray in the second row. Type BO for the Plate Layout Position.

4 In the third row, set up the sample inlet tray.

a. Click the Plate Type Name cell and then select the correct plate type, either PA 800 Plus Sample Tray 

or PA 800 Plus 96 Well Sample Tray.

b. Click the Plate Layout Position cell and then type SI.

c. Click  (Vertical Discontinuous Plate Sequencing Mode) to indicate the order in which the vials are 
accessed during the run.

5 Repeat step 4 to set up the sample outlet tray in the fourth row. Type SO for the Plate Layout Position.
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Run the Samples with the Waters Empower™ Software
Figure E.14  After Defining All Plate Types

6 Click OK to save the changes and close the dialog.

Create the Sample Set Method and Run the Samples

1 In the Empower™ Software Project window, click File > New Method > Sample Set Method.

The New Sample Set Method Wizard opens.

2 Click Use the Sample Set Method Editor instead of the wizard and then click Next.
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Run the Samples with the Waters Empower™ Software
Figure E.15  New Sample Set Method Wizard

The Sample Set Method Editor opens.

3 Set up the Sample Set Method.

a. In the first row, select IgG HR Conditioning in the Method Set/Report or Export Method cell.

b. For rows 2 through 17, select IgG HR Separation in the Method Set/Report or Export Method cell.

c. For row 18, select IgG HR Shutdown in the Method Set/Report or Export Method cell.

d. Add the required information for the samples. Refer to Table E.1. Use the default values for the other 
fields.

The completed Sample Set Method is shown in the following figure.

Table E.1  Required Fields for a Sample Set Method

Name Description

Plate/Well The position of the sample in the sample tray.

# of Injs The number of times the sample is to be injected.

SampleName The name of the sample.

Run Time (Minutes) The duration of the run.

CAUTION: Possible Wrong Result. Make sure that the Run Time is greater 
than or equal to the duration of the time program in the instrument 
method. If the Run Time is shorter, the system stops the run before the time 
program is complete.

Note: The Level and Reference Level columns are hidden in the following figure.
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Run the Samples with the Waters Empower™ Software
Figure E.16  Sample Set Method

4 Save the Sample Set Method.

a. Click File > Save.

The Save current sample set method dialog opens.

b. Type IgG Sample Set Method in the Name field.

c. (Optional) Type information in the Method Comments field.

d. If prompted, type the Empower™ Software password for the current user in the Password field and 
then click Save.

The method set is saved to the current project.
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Run the Samples with the Waters Empower™ Software
5 Click Tools > Run Samples.

Figure E.17  Select Desired Chromatography System Dialog

6 Click the system to be used and then click OK. Make sure that the instrument is configured with a 

PDA detector.

The Run Samples window opens.

7 Click  (Load Sample Set).

The Load Samples dialog opens.

8 Click Load using a previously created sample set method and then click OK.

Figure E.18  Load Samples Dialog
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Run the Samples with the Waters Empower™ Software
Figure E.19  Open an existing sample set method Dialog

9 Click IgG Sample Set Method in the list and then click Open.

The sample set method opens in the Samples tab.

10 In the Empower™ Software Project window, click  (Start). Data acquisition starts.

During the run, the text in the row in the Sample Set Method window for the sample being acquired 
appears red.

11 During the run the following actions are available:

 • (Optional) Click  (Stop) to halt data acquisition.

 • View the voltage and current data.

When the run ends, the text in all rows in the Sample Set Method window appears red.

Import the Instrument Methods

1 Open the Methods folder on the PA 800 Plus Empower™ Driver DVD.

2 In the Empower™ Software Pro Interface window, click Browse Projects, click the project of interest, and 

then click OK.
IgG Purity and Heterogeneity Assay Kit For the PA 800 
Plus Pharmaceutical Analysis System

Application Guide

60 / 66 RUO-IDV-05-6935-C



Run the Samples with the Waters Empower™ Software
Figure E.20  Empower™ Software Pro Interface Window

The Project window opens.

3 Click the Methods tab.

4 On the Windows desktop, click each min file in the Methods folder and then drag it to the Project window.

The instrument method is added to the project and can be edited and added to a method set like any other 
method.
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Contact Us
Customer Training

 • In North America: NA.CustomerTraining@sciex.com

 • In Europe: Europe.CustomerTraining@sciex.com

 • Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center

 • SCIEX University™

Purchase Consumables

Reorder SCIEX consumables online at store.sciex.com. To set up an order, use the account number, found on 
the quote, order confirmation, or shipping documents. The SCIEX online store is currently limited to the US, 
UK, and Germany but will be expanding to other countries in the future. For customers in other countries, 
contact the local SCIEX representative.

SCIEX Support

SCIEX and its representatives maintain a staff of fully-trained service and technical specialists located 
throughout the world. They can answer questions about the system or any technical issues that might arise. 
For more information, visit the SCIEX website at sciex.com or contact us in one of the following ways:

 • sciex.com/contact-us

 • sciex.com/request-support
Application Guide IgG Purity and Heterogeneity Assay Kit For the PA 800
Plus Pharmaceutical Analysis System

RUO-IDV-05-6935-C  65 / 66

https://training.sciex.com
https://training.sciex.com
https://sciex.com/education
https://sciex.com/contact-us
https://training.sciex.com
https://store.sciex.com
https://sciex.com
https://sciex.com/request-support
https://store.sciex.com


Contact Us
CyberSecurity

For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation

This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest version, go to 
https://get.adobe.com/reader.

To find software product documentation, refer to the release notes or software installation guide that comes 
with the software.

To find hardware product documentation, refer to the Customer Reference DVD that comes with the system or 
component.

The latest versions of the documentation are available on the SCIEX website, at
sciex.com/customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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